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How Do | Know If My PDF Is Accessible?

The Session begins at 1:00 pm CST
We will be testing audio quality periodically

The content and materials of this training cannot be used or distributed without permission. This training is
funded under award #H133A060097 from the U.S. Department of Education through the auspices of the
National Institute on Disability and Rehabilitation Research (NIDRR. For permission to use training content or
obtain copies of materials used as part of this program please contact us by email at
adata@adagreatlakes.org or toll free (800) 949-4232 (V/TTY) in IL, IN, MI, MN, OH, and WI. For other all
other states call (312) 413-1407

Useful Keyboard Shortcuts

Full list - Keyboard Shortcuts from the Help menu on
the Menu Bar.

Speaker level Up:

Windows: Ctrl+Alt+Up Arrow

Mac: Command-Option-Up Arrow
Speaker level Down:

Windows: Ctrl+Alt+Down Arrow

Mac: Command-Option-Down Arrow
Chat: Move cursor to the Message text box
Windows: Ctrl+M

Mac: Command-M
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More keyboard shortcuts

e Open Closed-Captioning window
Windows: Ctrl+F8
Mac: Command-F8

* Close Closed-Captioning window
Windows: Alt+F4 or Ctrl+W
Mac: Command-W

Listening to the Webinar

e The audio for today’s webinar is being broadcast through
your computer. Please make sure your speakers are turned
on or your headphones are plugged in.

* You can control the audio broadcast via the Audio & Video
panel. You can adjust the sound by “sliding” the sound
bar left or right.

* |f you are having sound quality problems check your audio
controls by going through the Audio Wizard which is
accessed by selecting the microphone icon on the Audio &
Video panel

<4
!

'b AUDIO & VIDEO

B —T—

| Talk | I Video | };Q\ |

Great Lakes ADA Center

9/15/2015



How Do | Know If My PDF Is Accessible? 9/15/2015

Listening to the Webinar, continved

If you do not have 1-712-432-3066
sound capabilities on

Pass Code:
your computer or 148937
prefer to listen by

This is not a Toll Free number
phone, dial:

Listening to the Webinar, continued

MOBILE Devices supported include iPhone, iPad,
Android Devices, Kindle Fire HD)**
Individuals can download the free Blackboard

Collaborate App from the Apple Store, Google Play or
Amazon

S

**Closed Captioning is not visible via the Mobile App and there is limited access to the white board for
individual's using voice over technology

Great Lakes ADA Center 3
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Captioning

* Real-time captioning is provided during this
webinar.

e The caption screen can be accessed by choosing
the iconin the Audio & Video panel. |

[ v aunio & vioeo B

Wive Fio}

e Once selected you will have the option to resize
the captioning window, change the font size and
save the transcript.

Submitting Questions

¢ You may type and submit questions in the Chat Area Text Box or press Control-M
and enter text in the Chat Area

¢ If you are connected via a mobile device you
may submit questions in the chat area within
the App

¢ If you are listening by phone and not logged in to
the webinar, you may ask questions by emailing
them to webinars@ada-audio.org

Please note: This webinar is being recorded and can be accessed on the website at www.ada-audio.org within 24
hours after the conclusion of the session.
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Customize Your View

» Resize the Whiteboard where the Presentation
slides are shown to make it smaller or larger by
choosing from the drop down menu located
above and to the left of the whiteboard. The
default is “fit page”

Customize Your View continued

Resize/Reposition the Chat, Participant and
Audio & Video panels by “detaching” and
using your mouse to reposition or
“stretch/shrink”. Each panel may be detached
using the = icon in the upper right corner of
each panel.

Great Lakes ADA Center
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Setting Preferences

Depending on your system settings you may receive visual
and audible notifications when individuals enter/leave the
webinar room or when other actions are taken by
participants. This can be distracting.

To turn off notifications (audible/visual)
— Select “Edit” from the tool bar at the top of your screen
— From the drop down menu select “Preferences”

— Scroll down to “General”

* select “Audible Notifications” Uncheck anything you don’t want to
receive and “apply”
¢ Select “Visual Notifications” Uncheck anything you don’t want to
receive and “apply”
— For Screen Reader User — Set preferences through the setting
options within the Activity Window (Ctrl+slash opens the
activity window)

11

Technical Assistance

If you experience any technical difficulties

during the webinar:

1. Submit a message regarding your issue via the
chat area and the Moderator will address your
concern via a private chat with you and/or refer it
to one of the Great Lakes ADA Center IT Staff to
contact you off line; or

2. Email webinars@ada-audio.org; or
3. Call 877-232-1990 (V/TTY)

Great Lakes ADA Center
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How Do | Know If
My PDF Is Accessible?

Christy Blew, M.S., C.C.T.
IT Accessibility Specialist
University of lllinois

Objectives

e Be familiar with accessible PDF terms (ie, tags)
and location of accessibility checking tools in
Acrobat Xl

e How to activate and use the Form Editor to
add Tool Tips to form objects

* |Identify at least three items that are needed
to make a PDF accessible

Great Lakes ADA Center 7
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May PDF be ever in your favor

When you hear
“‘Accessible PDF”

15

Housekeeping

e Adobe is a company; they are the creators of
Acrobat

e Acrobat is a tool for creating, editing and
viewing PDF files, yet is not a word processing
program

e PDF is an export format type of document.
Just as you would get a piece of paper from a
printer, you get a PDF from Acrobat

Great Lakes ADA Center 8
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PDF Structure

Visual Layer
(also referred to as the Physical Layer)
This is what you would associate as a “PDF
File”. It is the version that would exist if you mafyou
were to print out the PDF in a hard copy. ‘//'
SUIy se
Content Layer '}/ e
(also referred to as the Text Layer) -y
This layer contains the textual information 7 ' 4
that is associated with the Visual Layer. In an F |
accessible PDF, the reading order of the f 7-6/"[‘ Of f)
Content Layer mimics the order implied by ¥ ]//S // ’
the Visual Layout of the document. J Ua ay
er s
Tags Layer ‘ . ________-‘l. .
¢ The Tags Layer contains the PDF tagging . 2
structure (similar to HTML markup for a _" Sl‘/'[/c‘[‘ .
webpage) that is used by assistive .
technology. - 7_ U/-a/ 'y
L
K ags ;
teens . .

17

PDF “Tags”

e “Tags” provide a structured, textual
representation of the PDF that is presented to
assistive technology (AT) such as screen
readers.

e AT can determine paragraphs, lists, tables,
form elements, etc. from tags.

* A PDF without tags appears either blank or as
one large block of text to AT.

Great Lakes ADA Center 9
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Where to find “Tags”

Left side icon panel: the
tagicon

View > Show/Hide >
Navigation Panes > Tags

19

PDF/UA

ISO standard for accessible PDF, sets clear rules
for developers and authors of tagged PDF
documents and forms.

On February 18 2015 the US Access Board
announced its Proposed Rule for US federal policy
on accessibility, commonly known as Section 508.
The proposed rule identifies PDF/UA as
equivalent to WCAG 2.0 for “appropriate
content”

http://www.access-board.gov/news/1717-board-proposes-updated-ict-accessibility-requirements

20
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PDF/UA Description

A way to use Acrobat to produce documents available
to all persons, including those using AT

Tags must correctly represent the document's semantic
structures (headings, lists, tables, etc)

Problematic content is prohibited, including illogical
headings, the use of color/contrast to convey
information, inaccessible JavaScript, and more

Meaningful graphics must include alternative text

Security settings must allow assistive technology access
to the content

Fonts must be embedded, and text mapped to Unicode

21

Evaluation & Remediation

Most people are trying
to find out if a PDF is
accessible or trying to
fix one they know is not
accessible

Yes, this can be a
nightmare!

22
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Why Evaluate?

* Sometimes no access to original document or

applications conversion does not maintain
tagging structure

Currently there is no tool to automatically check a
PDF file for functional accessibility.

There are tools currently that check some items,
but to check a PDF for full accessibility, you still
need to do manual checking.

“Quick Checks”

Renderable Text — Text vs. Image
Navigation Structure — PDF “Tags”

Text Descriptions — Non Text Descriptions
Table Structure

Form Elements (including tab order)
Reading Order

24
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NOTE!!!

e Some browsers will try
to “guess” what a PDF
has in it when there are
not tags. Some people
mistake this as being
“accessible” because
the browser finds text

* Most of the time AT will
still struggle with the
PDF

25

Accessibility Checker

e Built in Accessibility
Checker

* Detailed report on
accessibility

* |s agreat 1% pass for
accessibility

* Easy to fix issues
* Notes manual checks

26
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Using the Accessibility Checker

DOUBLE FACEPALM

MAILWITH __ ONLY,CONTAINS A
NOSUBIECT  INACCESSIBLE PDF

27

* Right click on an issue

Working With Results

to get more information

— Fix

— Skip Rule
— Explain

28

Great Lakes ADA Center
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Just keep breathing....

et |

29

“Complex PDF” Checks

Data Tables

e Use the Tags panel to check if cells are marked up with TD and TH
correctly

Charts
e Charts are considered non-text elements and should have
associated alt text

Forms
¢ Forms need to have Tool Tips and be a part of the Tag structure

Multimedia
¢ Audio should have a text transcript, Video should be captioned.

30
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Table Rules

e All tables must have at least one heading row
e Tables with a heading row and heading

column must use ID’s to identify cells

31

Table Editor

Activate Touch Up
Reading Order Panel

Table elements show
with “X” through them

Right click on table

Select Table Editor

Pl

E‘.uh Mfar ahon Womnen’s W Fe suks

P
T

WEG ory, AmEnda

¥ Show reading order panel

Show page content groups

v Display like elements in a single box

Show table cells

¥ Show tables and figures

Edit Table Summary

Clear page structure

32

Great Lakes ADA Center
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Identifying Cell Types

« Cells will highlight

e Color coded based on cell o
type o

™ Phee | ol Tiwe WAL Ty
. . LT Table Editor Opticns.. e e e

e Select cell, right click, to Eomm e e o
Open properties caron, Susannah 3 wios | 15328 | oszss | sz

* Change cell type here

e Change colors in Table

Editor Options
Change to Header Cell
* Select cells to change r“w e N i B
* Select Table Cell
Properties
* Change to Header Cell

Great Lakes ADA Center 17
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e Each TH cell must have
an unique ID assigned
toit

e Enter this in the ID field
in the properties

e Use identifiable words
for ID

Assigning and ID to TH

Boston Mearathon Women's WC Resdts

’Mam: Phce | BB | Time

HALF

Finish

McFadden, Tatyana = | I ‘lnsza 0:50:17
LY

1:45:24

VICGrory, Am«nda\\ Table Editor Qptions...

|49115 0:52:37

1:49:19)

Assecisted Header Cell D5

35

* Assistive technology
uses the ID’s to
associate the TD cells

* In Properties, select the
“+” to show all available
IDs

e Select the ID’s that
correspond to that cell

Associate TD with TH

‘Bosion Meathon Womes's WC Rendls

Phce l [T I Time. ‘

HALF

3 | TebleEditor Options.

OV T

sl e

36
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e THvsTD

Check Table in Tags

e Correct # of cells

¢ Double Check Table in
Tags Panel

e Complex Table Check

CIo|

@
=8 T s
?lj o B oston Marathon Women's WC Results
B 5] <Sect>
McFadden, Tatyana 1
McGrory, Amanda 3
Scaroni, Susannah 6
BEE <TH>
W BB Moore, lill B8
BEE <TH>
= Time
BEE <TH» F
W HALF
B <TH>
4 Finich
E1EE <TR>
37

Merged cells

Complex Tables

Gender Name Time HALF Finish
Kim, Gyu Dae 1:35:59 0:4411 13559
Genrge, Josh 1:37:41 0:45:43 12741
Pike, Aaran 1383 0:45:11 12943
Senbeta, James 1:08:41 0:63:28 1:46:41
Bleakney, Adam 1657 | 06926 14557
Hhen Siemann, Brian neead | 05137 1:48:26
Park, Peter 1:5431 0:53:22 15431
Kozarek, R obert 15450 0:53:23 15450
Grass|, David 20047 | 08832 2:00:47
Martin, Raymand 2:00:29 0:55:39 2:01:28
oy, Laurence 21524 | 10328 21514
McFadden, Tatyana Les24 | 050027 1:45:2
McGrary, Amanda 10829 0:52:37 1:49:19
Women
Scarani, Susannah 15228 0:52.58 153:28
Magre, dill 2:26:20 1:06:47 2:26:20

Does not seem to match up

f3erder hame Time HALF Finish
Kim, Gyu Dae 1:35:59 0:44:11 1:35:59
George, laah Ti7a1 | 0:46:83 Teval| |
Pike, Aaran 139:13 1 139:23)
Senbeta, James 0:48:28 1:44:41
Bleakney, Adam 1:45:57 0:43:26 1:45:57]
Men Siemann, Brian 1:49:19 0:51:37 1:49:14
Fark, Fater 1:54:31 0:53:22 1:54:21
Kozarak, Aiobert 1ses0 | os3z 1545
Grassi, David 2:00.47 0:55:32 2:00:47|
Wiann, Azymond zonzs | ossis 20129
oy, Laurence z1se | nosze || zasad
McFadden, Tatyana || L4524 | 05017 || 19524
McGrary, Amanda Taas | 05237 Tasas |
Scaroni, swannan 15328 | os2se 153.29]
Moore, 3l 2520 | wo0sar || 226

38

Great Lakes ADA Center
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Fixing Complex Tables

Retagging gets close Compare to Tags to clean up

Gerder rame Time HALF Finish - r— =
im, Gyu = 135 = G
George, Josh 13741 0:46:43 1:37:41 George, Jush 1:37.41 0:46:43 1:37:41]
Fike, Aaron 13913 | 0451 [ETE 13813 | o:san 13813
beta, James 16461 | oasz8 1:44:61 Taad 1484
16557 | 0426 214535 - 1455 1:45:5
Men 14914 0:51:37 1:48:14 men || siemann, Brian 1:48:1 49:
1:54:3 154 Park, Peter 15631
1:54:50 0:52:23 1545 Kozarek, Rabert 1:54:50 0:53:32 1:54:50)
200:47 D532 2:00:43 Grassi David 2:00:47 0:55:32 2:00:47|
i artin, Raymond 20129 | 05538 2:01:29
21504 | 10324 2.15:14 21528 | 10328 23514
McFadden, Tatyana 14524 | 0:50:17 1:45:24)
. s 1:49:1
15328 05258 1:53:28 o Scarani, Susannah 15328 05258 1:53:28
Maore, Sil 220 1:04:47 16:20 Moore, lil 22620 104:47 2:26:20)

’ L]

Don’t Get Discouraged by Tables
* Yes, it may take extra time

to figure out
* Yes, you may have to do it

more than once
* Yes, you may use

inappropriate language

AND....
YOU CAN DO IT!

Great Lakes ADA Center

9/15/2015
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Forms

Fie €0 View Window Help ®
2 create ~ ‘ @ B & 6 2 | edgeop Bk Customize ~ =l
[N & | @ [se=]-] | 1 [E]

Tools I Sign | Comment
&

"'+ Content Editing

Currently there are no form fields in thiz PDF. Do you want
you?

Ves No

¢ Tools > Forms > Edit
e Auto-detect based on form

41

Form Elements

e Text Fields —Fill in the blank
* Check Boxes — Select one or more options
» Radio Boxes — Select only one from multiple

options

42

Great Lakes ADA Center
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Form Editing Mode

e Add Fields
Edit Fields
Close Editor

Forms @ Close Form Editing

.| ¥ Tasks

Bl Add New Field -

B8 Edit Fields v

@ Distribute
Other Tasks v

EchoSign

Convert to EchoSign Form

Fields
SortBy v Tab Order ~
|| Pagel
43
Add a Field
SAMPLE QUERY {@ s
Mame: <=l I
Address; ; Eadio Button
fole (ch] SAMPLE QUERY P oo
Name; ! Sl
EDUC‘ T Field Name: 5 parcode
Degrees| b B s i el
Role (chy - Reauredfied .%f;;- L] Page1
Ay
e Add New Field
* Place Field
* Enter (visually will change)
e Select ALL PROPERTIES 44

Great Lakes ADA Center

9/15/2015
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Tooltips
e Assistive Technology
identifies form fields via |Errs——
too Iti p General | Appearance | Position | Options | Actions [ Format | validate | Calculate
Mame: [ome
N g [Nemd
* Make sure tooltip notes
what needs to be
completed
« Sometimes may need to == = i
put a full questionin a
tooltip
Checking Tooltips

* Check in the properties
box in the Form Editing
Mode

\:l Masters
* Hover mouse over form

element in reading

mode

46
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Form Order

[ I P A

L, | » Tasks
SAMPLE QUERY Fietds
R Sort By ~ Tab Order ~
Name: | [name .+ ________ B Pogel
= = = neme
] Address: | Jadaress] .-I ......... == Il e
% role
a1 K ) student
Role (choose only one): Student  [EH] Admin i
N - 5 admin
4o @ associntes
= | _ = bachelors
=T m ™
EDUCAT'ON ',a" ’—"‘— ¥l masters
] - - 27~ @ doctonst
Degrees Earned (check all that ap,n.bf-)ﬂ.’ Pl T & doctorate
- - - -
,—" P ‘,0 -
B B Associates=” -
- -
- - P
— P P P
=3 Bachelors < g PPl
] e Pt
— .- -
= Masters -
- ’J
-
- — 'l’
[ Doctorate
=

47
Change Form Tab Order
Forms
* Drag and Drop ] > Tasks
Fields
SortBy ¥ Tab Order ~
e Match order to logical Bt
reading order of 1 e
document Sy
{#l doctorate
48

Great Lakes ADA Center
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SAMPLE QUERY

Add/Edit Form Elements

Name:
Address: e

SAMPLE QUERY '

49

You Survived!

50

Great Lakes ADA Center
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PDF/UA Resources

* PDF/UA — Wikipedia:

http://en.wikipedia.org/wiki/PDF/UA

PDF/UA in a Nutshell:
http://www.pdfa.org/publication/pdfua-in-a-nutshell/

Making a simple document accessible in
Acrobat Pro XI: http://itaccessibility.illinois.edu/pdf/docaccessXI

51

Accessible PDF Tutorials

We bAl M - http://webaim.org/techniques/acrobat/

Lyn da.com - http://www.lynda.com/Acrobat-tutorials/Creating-
Accessible-PDFs-2014/147579-2.html

CaI State = http://www.calstate.edu/accessibility/tutorials/pdf.shtml

Google: “PDF Accessibility Tutorials”

Great Lakes ADA Center

9/15/2015
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About Christy

Christy Blew is an IT Accessibility Specialist in the Division of
Disability Resources and Educational Services (DRES) at the
University of lllinois at Urbana-Champaign. She has over 15 years of
experience in developing and using internet technologies to deliver
information to people and has been working with IT accessibility
education for over 10 years. Christy is part of the ITaccess initiative
at the University of lllinois that focuses on the awareness,
evaluation, and education of accessibility of electronic information.
Her online and classroom training sessions include accessibility
issues with Word, PowerPoint, and PDF. She is a member of the
W3C Protocols and Formats working group and the International
Association of Accessibility Professionals (IAAP). Christy currently
holds a Masters in Technology and a Certification in Computer
Science from Eastern lllinois University, and a certificate in Audio

Description through Audio Description Associates, LLC.

Christy can be reached at clblew@illinois.edu.

53

and will be archived at

BINFARSSERIES

5

Thank you for participating!

NEXT SESSION IS NOVEMBER 19, 2015

Social Media, Accessibility,
and Disability Inclusion

The session today was recorded

HTTP://ADA-AUDIO.ORG/ARCHIVES/ACCESSIBLETECH/

54
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